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Working with Multiple Samples: Tricks to Save Time 
 
The purpose of this article is to review the features in CasaXPS for aiding those working 
with large sets of samples, where the data are not necessarily identical in nature but 
nevertheless have a common theme. For example, a series of measurements might be 
made on a set of stainless steel samples, where each experiment includes a survey plus a 
set of high resolution spectra; however, while the spectra always include data from the C 
1s, O 1s and N 1s energy intervals, other intervals such as Cr 2p or Fe 2p may also be 
included in the data files. If the data were identical in terms of the number of spectral 
regions and order of acquisition, and such samples were routinely analysed over an 
extended period of time, then it would be worth investing the time to setup the required 
batch processing files. The fact that the data includes variations on a theme means that 
batch processing is not an option. Fortunately, all is not lost. Version 2.3.12 offers many 
features for manipulating multiple samples and by applying some of the tricks-of-the-
trade, large sets of data files can be processed with relative ease. The tricks on offer are 
the subject of this article. 
 
The topics covered are: 

• Opening multiple files 
• Selection mechanism for VAMAS blocks 
• One shot energy calibration for multiple files 
• Propagation based on matching species/transition to multiple files 
• Tile display format and printing the results. 

 

Opening the Files 
 
When manipulating multiple samples, it is sometimes convenient to merge the data into a 
single Experiment Frame. Other times, the data is best maintained as individual files. In 
either case the files can be opened in one action. Both the Open and Merge and Open 
options on the File menu (Figure 1) offer a File Dialog window and by selecting a range 
of files, the action associated with the window will be applied to the selected files when 
the Open button on the dialog window (Figure 2) is pressed. 
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Figure 1 

 

 
Figure 2 

 

Opening sets of files into separate Experiment Frames 
 
Once the Open File menu item has been selected and the Open VAMAS File dialog is 
active, the normal operations for making selections in Windows programs are available 
for choosing the files to be opened. A single file is selected with a left-click of the mouse, 
which can be followed by holding the Shift or Control keyboard keys down and left-
clicking the mouse over a different file. The Shift modifies the left-click action and 
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causes a range-selection to occur, where all the file names between the first and second 
left-clicked file names become selected. The Control key causes files to be added to the 
current selection. The selection in Figure 2, in which all the files in the current directory 
are required, is achieved by first, left-clicking on a file name to ensure the list of files is 
the active item on the dialog window, then pressing Ctrl-A. All the files in the current 
directory, subject to the “Files of type” filter, become selected. On pressing the Open 
button on the dialog in Figure 2 an Experiment Frame, one for each file selected, appears 
in the CasaXPS main window. 

Selection Mechanisms in CasaXPS 
 
With large sets of similar data, the intension is typically to apply the same set of 
processing operations to each file, prepare the display and print the results. The problem 
is therefore to manipulate the data such that these operations are as painless as possible. 
The basis for any operation in CasaXPS is the selection of one or more VAMAS blocks, 
so before describing the operations, the new selection mechanism for multiple files are 
described first. 
 
An Experiment Frame offers two views into a VAMAS file, namely, the left-hand-side in 
which spectra are displayed in graphical format and the right-hand-side browser. Both 
play a role in defining the target and source for various operations such as processing and 
propagating the results of processing to other data blocks. 
 
The logic governing the use of these two selection mechanisms requires some 
explanation. In general, a single target for a processing operation is defined as the active 
VAMAS block in the active display tile of the Experiment Frame with input focus. The 
active display tile is the tile displaying data in the left-hand-side of the Experiment Frame 
for which the title to the data is marked as highlighted text. The active VAMAS block is 
the block selected first using the mouse and the browser at the time the data are displayed 
in the active display tile. Property pages such as those on the Spectrum Processing dialog 
window and the Annotation dialog window act on a single target data block and therefore 
the concept of the active VAMAS block is central to understand the cause and effect 
mechanism within CasaXPS. Once a block has been manipulated using the active 
VAMAS block, the progression is to transfer these processing operations to other blocks 
requiring the same manipulations. Hence the requirement to specify a source block and a 
set of target blocks. The source for a propagation action is specified using the active 
VAMAS block mechanism, while the target blocks are defined using the selection in the 
Experiment Frame browser. Anyone processing XPS depth profiles (see The Casa 
Cookbook page 121) would routinely use these concepts, where all the selections in terms 
of active display tiles and the browser are made within a single Experiment Frame. When 
multiple files are involved, the definition for the source and target blocks extends to 
cover selections over many different Experiment Frames. 
 
The method for selecting data blocks in the browser of an Experiment Frame is not 
limited to a single Experiment Frame. Provided the Control key is held down, any 
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subsequent selections made by left-clicking the mouse adds to the set of currently 
selected data block. Figure 3 shows a set of six files where a survey spectrum from each 
file is displayed in the active tile and are also the current selection in the Experiment 
Frame browsers. While these data blocks could have been individually selected using the 
mouse, for larger sets of files, relying on the mouse and the Control key to make such 
selections is not very time efficient. To improve the ability to select related data blocks 
across Experiment Frames, the Select menu (Figure 3) of the CasaXPS main window 
offers options for selecting blocks throughout a set of Experiment Frames. Function keys 
have been associated with these menu options so that the selections can be made without 
excessive mouse movements, if desired. 
 
 

 
Figure 3 

 
Select All Blocks (Ctrl F3): All data blocks in each Experiment Frame are selected via 
the menu option or alternatively hold the Control key down and press the F3 function key 
on the keyboard. 
 
Select All Matching Blocks (Ctrl F4): The selected blocks in the Experiment Frame with 
input focus define the species/transition fields used to match against all the data blocks in 
the current set of Experiment Frames. The result of pressing the Select All Matching 
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Blocks menu option is all data blocks from the current set of Experiment Frames with 
identical species/transition fields are added to the current set of selected data blocks. For 
example, to add the set of O 1s data blocks to the selection shown in Figure 3, the Control 
key must be held down and one O 1s data block from any file selected. The Control key 
must be held down to prevent the survey spectra from becoming deselected.  While input 
focus is still on the Experiment Frame with both the survey and the O 1s selected, 
holding the Control key down and pressing the F4 function key results in the selection of 
both the survey and the O 1s in every Experiment Frame. The data displayed in the 
scrolled list of tiles in each Experiment Frame are unaffected by the action of the menu 
option. 
 
Select and Display Matching Blocks (Ctrl F5): The data displayed in the active tile is 
affected by the Select and Display Matching Blocks menu option. The intention is to 
change the active VAMAS block in each and every Experiment Frame using the same 
selection mechanism as Select Matching Blocks. The need to adjust the active VAMAS 
block is motivated by the new energy calibration option which performs a calibration 
across files (see below). 
 
 

 
Figure 4 

 

Energy Calibration and Multiple Files 
 
Charge compensation issues often cause photoelectric lines to appear shifted on a sample-
by-sample basis. Figure 4 illustrates the problem for the set of six samples displayed in 
separate Experiment Frames in Figure 3. Each set of data is shifted in energy by 
potentially a different amount and as a result, simply creating a region for one spectrum 
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then propagating the region to the set of spectra in Figure 4 would typically fail to define 
the background in an ideal fashion. It is therefore advisable to energy calibrate the spectra 
from each file before performing the propagation of regions and/or components. As a 
result, two new options (Figure 5) on the Calibration property page of the Spectrum 
Processing dialog window offers a means of calibrating sets of spectra in different 
Experiment Frames as a single operation. 
 

 
Figure 5 

Energy calibration is often performed to ensure the saturated carbon peak appears at 
binding energy 285.0 eV. The implication is therefore that a peak-fit is required for the 
carbon data in order to establish the appropriate position for the saturated carbon 
transition. The problem with data such as that displayed in Figure 4 is that an energy 
calibration must exist before a peak model can be propagated to the data from the 
different files. Without an initial calibration, the location of the background region and 
synthetic peaks may be in error by several eV and therefore automatic peak fitting fails to 
produce appropriate results as exemplified in Figure 6. For this reason, the energy 
calibration is sometimes performed in two stages. First a calibration based on the 
maximum intensity in a range is performed. Although not perfect, often the range 
calibration is more than good enough for the application, but in the event that greater 
precision is required, a second calibration based on the position of a synthetic component 
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is available. The range calibration allows peak models to be copied and fitted to the data 
in the different files and once these peaks are fitted to the data, the second form of 
calibration is applied, where the position for one of the synthetic components define the 
fine adjustment needed to establish the precise energy calibration. 
 
 

 
Figure 6 

 
Both calibration buttons for energy-shifting data in multiple files require the use of the 
selection mechanism. The process of energy calibrating a file centres on identifying a 
spectrum from which the measured energy position of a peak is computed. Each 
Experiment Frame must define a single spectrum, from which the apparent location of a 
peak is determined and together with the known value, entered in the True field on the 
Calibration property page, are sufficient to calculate the shift required to correctly 
position the photoelectric lines in binding energy. The spectrum used in this calculation 
in each Experiment Frame is the active VAMAS block for that Experiment Frame. Hence 
the existence of the Select and Display Matching Blocks menu option described above. 
The display in each Experiment Frame can be set to a given species/transition at a click 
of a button. For example, the C 1s blocks can be used to calibrate the data in Figure 3, 
therefore in order to perform the calibration, each Experiment Frame must display the C 
1s data in the active tile. Simply selecting a C 1s data block in any Experiment Frame 
then pressing the Ctrl+F5 key-sequence causes all the C 1s data blocks to highlight and at 
the same time display in the scrolled-list of tiles; thus, making the C 1s blocks the active 
VAMAS block in each Experiment Frame. By using the active VAMAS block to specify 
the spectrum from which the energy shift is computed, the browser selection is available 
for indicating those data block to which the calibration must also apply. 
 

 7



 Copyright © 2005 Casa Software Ltd. http://www.casaxps.com 
 
There is an underlying assumption about the nature of the data in the files under 
consideration. It is assumed that the spectrum used to perform the calibration is in the 
first row of the browser. The data in Figure 3 includes two C 1s regions, one acquired at 
the beginning of each measurement and one acquired after all the other spectra are 
recorded. As the data file stands, Ctrl+F5 would always make the first of these two C 1s 
spectra the active VAMAS block. If for any reason it is desired to calibrate using the 
second C 1s spectrum, it would be necessary to distinguish between the two C 1s spectra 
by changing the species/transition fields in the VAMAS block information so that these 
two spectra differ such that both appear on the first row in the browser. 
 
In summary, the sequence of steps leading to an accurately calibrated set of files is as 
follows: 

1. Perform an initial energy calibration based on locating the maximum intensity in a 
range of energies. 

2. Propagate the regions and components to the spectra. 
3. Recalibration using the option to calibrate using the first component defined on 

the spectrum in the active tile (the active VAMAS block). 
 
The steps will now be described using the data in Figure 3. 
 

Energy Calibration: An Example 
 
The data in Figure 3 is a selection of files taken from a larger set all acquired from 
stainless steel samples at different stages of cleaning. The data are essentially the same in 
nature but not all experiments were performed in the same order nor were the high 
resolution spectra limited to the same number of acquisition intervals. Energy calibration 
for each file is achieved by positioning the largest C 1s component peak (Figure 7) at a 
binding energy of 285 eV and adjusting the remaining spectra using the energy shift 
computed from the C 1s data. 
 
Processing of the survey spectrum in terms of quantification regions is dependent on 
calibrating the entire set of spectra using the C 1s peak-fit. The following steps are a 
guide to achieving this result. 
 

1. Load the spectra into separate Experiment Frames. Select the Open button on the 
File menu and move the current directory displayed in the File Dialog window to 
the directory containing the stainless steel data. Press Ctrl+A to select all the files 
in the directory and press the Open button on the dialog window. 

2. Create an initial calibration for the set of samples. Choose a representative file 
and open the Spectrum Processing dialog window, selecting the Calibration 
property page (Figure 5). Select and display the C 1s spectrum from the first row 
in the browser (Figure 7). Enter an appropriate range of energies in the Measured 
text-field (using “start-energy comma end-energy” e.g. 290 , 279) and the 
required position for the transition in the True text-field. It is important that the 
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range of energies is valid for all C 1s in all of the open files. Ensure the 
Experiment Frame in which the chosen C 1s spectrum has input focus. If not left-
click on the title bar of the Experiment Frame. Hold the Control Key down and 
press the F5 function key. All the C 1s spectra will be selected in the browser and 
the first C 1s spectrum will appear in the first tile as the active VAMAS block in 
each of the Experiment Frames open in CasaXPS. Confirmation of the action can 
be made by selecting the Cascade option on the Window menu and cycling 
through the open Experiment Frames by holding the Control Key down and 
repeatedly pressing the TAB key. Using the representative file, select all the 
blocks using the browser for which the energy calibration is to be performed and 
press the Crtl+F4 key. In each Experiment Frame, all the blocks with identical 
species/transition fields as those selected in the representative file will become 
selected. In this example, the representative data set already contains regions and 
components, therefore the tick-boxes for adjusting the region limits and positions 
of components should be ticked. Finally, press the button labelled Apply Range 
Calibration to All Files. The processing history for each of the blocks affected by 
the calibration step will now display the values used to adjust the peak positions. 

3. Propagate the processing information from the representative file. This action of 
propagating the processing from one file to others is covered below. 

4. Repeat the procedure described in step 2, but this time ensure the True text-field 
contains the correct energy for the peak in column A of the Components property 
page on the Quantification Dialog window and press the Apply 1st Comp 
Calibration to All Files button instead of the Apply Range Calibration to All Files 
button. 

 
Figure 7 

 9



 Copyright © 2005 Casa Software Ltd. http://www.casaxps.com 
 
Propagating Processing to Similar Data Blocks 
 
The Browser Actions dialog window (Figure 8) offers a means of transferring data 
reduction steps from the active VAMAS block to any block in any Experiment Frame. The 
concept used by the Browser Actions is that processing, regions, components etc. 
prepared on the active VAMAS block can be transferred to other blocks by simply 
selecting the blocks in the browser then right-clicking over the tile displaying the 
manipulated data. While still a means of propagating data reduction steps to other files, 
the Browser Actions dialog window is supplemented by a new option in version 2.3.12, 
which allows multiple blocks to be identified as the sources for the propagation, allowing 
at a stroke the entire processing performed on a file to be transferred to all the selected 
blocks in any Experiment Frame. The key feature is that the new form of propagation will 
match the species/transitions strings between the source blocks and the destination 
blocks. As a result the propagation procedure is less flexible about which blocks can 
receive the data reduction steps, but the transfer takes place with a minimum of fuss. 
 

 
Figure 8 
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The source for the new propagation option  on the top toolbar is the set of blocks 
displayed in the active tile. Once the data for a set of blocks has been prepared, the blocks 
are overlaid in the active tile, while the target blocks are those blocks added to the 
selection prior to pressing the toolbar button. For example, if all the Experiment Frames 
are involved in the analysis, the Ctrl+F3 key action will select all the blocks in every 
Experiment Frame. When the toolbar button is pressed, a dialog window appears showing 
both the set of source blocks, identified by their Block Id strings, and the set of target 
blocks together with the file names for each of the blocks. When the OK button is pressed 
on the dialog window, the propagation operation is performed once for each 
species/transition type loaded into the active tile. The Progress dialog window will also 
appear and disappear for each block overlaid in the active tile. 
 
Quantification reports generated from the set of selected blocks from multiple 
Experiment Frames are possible using the option on the Browser Operations dialog 
window. The section labelled Quantification offers a set of radio buttons (Figure 8) and if 
any option for Quantification other than the radio button labelled None is active, then a 
default quantification report is generated following the propagation action.  
 
A further option for quantification exists via the Quantification property page on the 
Annotation dialog window (see page 121 in The Casa Cookbook). A quantification table 
added to the display for a spectrum requires the appropriate selection of the blocks in the 
browser; therefore the tile display and browser selection must be prepared before printing 
the results. 

Formatting the Tiles and Printing 
 
Tile format files saved using the File menu can be prepared and saved to the directory 
CasaXPS.PTF to act as a template for displaying the data from multiple samples. These 
templates are applied to the set of open Experiment Frames, again via the options on the 
File menu (Figure 1). 
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